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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

•  Thorough knowledge of production activities in various manufacturing
environments.

•  Working experience with navigating Oracle Applications.

Prerequisites

•  Overview of the Supplier Management Process

•  Overview of the Requisition Process

•  Create, Manage, and Approve Requisitions

How This Course Is Organized

Issue RFQs to Obtain Bids and Quotations is an instructor-led course featuring
lecture and hands-on exercises.  Online demonstrations and written practice
sessions reinforce the concepts and skills introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Purchasing User’s Guide A82913-01

Additional Publications

•  System release bulletins

•  Installation and user’s guides

•  read.me files

•  Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Issue RFQs to Obtain Bids and
Quotations
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 Objectives Objectives

After completing this course,  you should be able to
do the following:
• Create requests for quotations
• Record quotation responses
• Define iSupplier Portal
• Describe Oracle Exchange and Oracle e-

Commerce Gateway RFQ features
• Perform setup and implementation requirements

for RFQs

After completing this course,  you should be able to
do the following:
• Create requests for quotations
• Record quotation responses
• Define iSupplier Portal
• Describe Oracle Exchange and Oracle e-

Commerce Gateway RFQ features
• Perform setup and implementation requirements

for RFQs
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AgendaAgenda

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations
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Contract
terms &

conditions

Negotiations
and award

RFP/RFQ
Development

and
distribution

Oracle Strategic Procurement
 Procurement Life Cycle

Oracle Strategic Procurement
 Procurement Life Cycle

Requisition
from

catalog
Order
mgmt. and
fulfillment

Receiving

Payment

Supplier
performance

Internal
compliance

Catalog
content
mgmt.

Reporting

OrderingSourcing

Analysis

Supplier
mgmt.

Opportunity
analysis

Contract
performance

Commodity
analysis
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Overview of a Request for QuotationOverview of a Request for Quotation

Enter Enter 
RFQRFQ

Suppliers fromSuppliers from
supplier listsupplier list

Supplier 1

Supplier 2

Supplier 3

Request for QuotationRequest for Quotation
• Header information

– Doc. type, ship-to, bill-to
– Quote effective date

• Line information
– Quantity
– Unit of measure
– Target price

• Min/max quantities
• Terms and conditions
• Hazardous materials
• Multiple shipment quotations

Request for Quotation
A request for quotation (RFQ) is a document you use to solicit supplier
quotations for those goods or services. Not all purchase requisitions require an
RFQ, and you do not need a purchase requisition to create an RFQ. However, if
the RFQ required check box is selected on a requisition, an RFQ is required for
that requisition.

Supplier Lists
Although you may send an RFQ to one supplier, usually you will want to send a
request for quotation to many suppliers to ensure that you get the best price and
terms possible. With Oracle Purchasing you create supplier lists so that you can
predefine groups of suppliers to whom you want to send RFQs. You can
establish supplier list according to criteria you define, such as item,
manufacturing category, geographic location or more.
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Overview of Creating RFQsOverview of Creating RFQs

Requisition
line
pool

Query existingQuery existing
lineslines

RFQRFQ

RFQRFQChoose linesChoose lines
fromfrom

query resultsquery results

AutomaticAutomatic
creationcreation

ManualManual
creationcreation

AutoCreating Request for Quotations
Oracle Purchasing provides automatic creation capabilities for documents. All
purchase requisition lines available for autocreation go into a single requisition
pool. Buyers can retrieve any of the requisition lines from the pool and use the
AutoCreate Documents window to create request for quotations (RFQs).
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Overview of QuotationsOverview of Quotations

Approve
supplier 

quote

Unapprove
 supplier 

quote

Requests for quotations

Quote repository

Supplier 1 Supplier 2 Supplier 3 Supplier 4

Quotations
A Quotation is a statement of the price, terms and conditions of sales a supplier
offers you for an item or service. Suppliers consider quotations as an offer to
sell when given in response to an inquiry such as a request for quotation.
A quotation may be verbal or written. You often get verbal quotations for minor
purchases by telephone. You usually send a request for quotation if you want a
written quotation from the supplier. Written quotations often have an effective
date and an expiration date.
Purchasing lets you approve quotation shipment for specific purposes so that
you can control the use of your sourcing information. You can approve
quotation information for specific purposes so that you can control the use of
your sourcing information.



Copyright © Oracle Corporation, 2000. All rights reserved.

Issue RFQs to Obtain Bids and Quotations
Chapter 1 - Page 9

Overview of the Approved  Supplier List

Copyright   Oracle Corporation, 2000. All rights reserved.
®

Overview of the Approved
Supplier List

Overview of the Approved
Supplier List

When ordering items, you can restrict your supplier
options to use only approved suppliers with the:
• Approved Supplier List
• Sourcing rules

When ordering items, you can restrict your supplier
options to use only approved suppliers with the:
• Approved Supplier List
• Sourcing rules

Approved Supplier List
For each commodity or individual item, you associate a list of suppliers and
relevant information about this relationship. Oracle Purchasing enables you to
set up and control your Approved Supplier List entries as global procurement
policies, or as local procurement options for a given plant or organization. The
Approved Supplier List is used in conjunction with Enhanced Sourcing rules.
For more information see the Manage the Approved Supplier List component.

Enhanced Sourcing Rules
Enhanced Sourcing rules enable you to define relationships between the
Approved Supplier List and your business rules for sourcing items and
commodities. Sourcing defaults can dramatically increase operational
efficiency.
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RFQ and Quotation TypesRFQ and Quotation Types

• Catalog
• Standard
• Bid

• Catalog
• Standard
• Bid

RFQsRFQs QuotesQuotes

Types of RFQs and Quotations
Catalog
•  Used for high volume items or items which suppliers send information regularly
•  Includes price breaks at different quantity levels
•  Quotations can be used for automatic sourcing
• Standard
•  Used for items ordered once or infrequently but not for a specific, fixed
quantity, location, and date
•  Includes price breaks at different quantity levels
• Bid
•  Used for a first time, single, large, or expensive item
•  No price breaks
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Integrating with Supplier SchedulingIntegrating with Supplier Scheduling

OracleOracle
suppliersupplier

schedulingscheduling

OracleOracle
PurchasingPurchasing

Approved Supplier ListApproved Supplier List
Sourcing rulesSourcing rules

Assignment setsAssignment sets

Shared informationShared information

Supplier Sourcing with Oracle Supplier Scheduling
When Oracle Supplier Scheduling and Oracle Purchasing are used in
conjunction they share supplier sourcing information. The following
information is shared.

• Approved Supplier List
• Sourcing rules
• Assignment sets
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• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations
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Overview of Request for QuotationOverview of Request for Quotation

Approve
supplier 

quote

Unapprove
 supplier 

quote

Request for quotation

Quote repository

Supplier 1 Supplier 2 Supplier 3 Supplier 4

Request For Quotation
You can send the RFQ to as many suppliers you want and decide how much
item information to provide to the suppliers. Each RFQ consists of header, line
and shipment information. In the header you define the RFQ Document Type,
the Ship-To and Bill-To locations and the Quote effecitivty dates. The line
region is where you define the goods or services for which you want the
supplier to quote. Included in this information are your requirements such as
unit of measure and optionally, a target price for negotiation purposes. You may
also include minimum and maximum order quantities and classification for
hazardous materials. You specify the terms and conditions for the RFQ. You
can request as many shipments quotation as you want. You might want to
provide multiple shipments if you want to receive quotations from your
suppliers for different ship-to locations, quantities or other criteria.
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Defining Supplier ListsDefining Supplier Lists

Use the Supplier Lists window to create or locate
unique lists of suppliers to aid in the procurement
activities.

Use the Supplier Lists window to create or locate
unique lists of suppliers to aid in the procurement
activities.

(N) Oracle Purchasing > Supply Base > Supplier List(N) Oracle Purchasing > Supply Base > Supplier List

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Defining Supplier Lists
Supplier Lists can be used repeatedly to decrease the amount of time spent
creating an RFQ.
Note: When you copy a supplier list onto your RFQ supplier list, Oracle
Purchasing copies every unique combination of supplier and supplier site that
does not already appear on the current RFQ supplier list.
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Creating a Request for QuotationCreating a Request for Quotation

Use the RFQs window to:
• enter and edit a request for quotation
• review and edit an RFQ autocreated from on-line

requisitions

Use the RFQs window to:
• enter and edit a request for quotation
• review and edit an RFQ autocreated from on-line

requisitions

(N) Oracle Purchasing > RFQs and Quotations > RFQs(N) Oracle Purchasing > RFQs and Quotations > RFQs

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Entering RFQ LinesEntering RFQ Lines

Use the RFQs window to enter and edit RFQ lines.Use the RFQs window to enter and edit RFQ lines.

(N) Oracle Purchasing > RFQs and Quotations > RFQs
(T) Items
(N) Oracle Purchasing > RFQs and Quotations > RFQs
(T) Items

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Selecting RFQ Currency InformationSelecting RFQ Currency Information

Use the Currency window to select the currency of
the RFQ and enter exchange rate information (if
applicable).

Use the Currency window to select the currency of
the RFQ and enter exchange rate information (if
applicable).

(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Currency
(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Currency

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Editing RFQ Terms and ConditionsEditing RFQ Terms and Conditions

Use the RFQ Terms window to edit the RFQ terms and
conditions defaulting from the Financials Options
window.

Use the RFQ Terms window to edit the RFQ terms and
conditions defaulting from the Financials Options
window.

(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Terms
(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Terms

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Entering RFQ Price Break InformationEntering RFQ Price Break Information

Use the RFQ Price Breaks window to enter pricing
information for an RFQ.
Use the RFQ Price Breaks window to enter pricing
information for an RFQ.

(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Price Breaks
(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Price Breaks

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Selecting SuppliersSelecting Suppliers

Use the RFQ Suppliers window to:
• enter the suppliers that will receive the RFQ
• review supplier activity

Use the RFQ Suppliers window to:
• enter the suppliers that will receive the RFQ
• review supplier activity

(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Suppliers
(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Suppliers

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Entering RFQ Shipment InformationEntering RFQ Shipment Information

Use the RFQ Shipments window to enter and review
shipment information for BID RFQs.
Use the RFQ Shipments window to enter and review
shipment information for BID RFQs.

(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Shipments
(N) Oracle Purchasing > RFQs and Quotations > RFQs
(B) Shipments

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating RFQs

... > Entering RFQ Headers

... > Entering RFQ Lines

... > Entering RFQ Supplier Information

... > Entering RFQ Terms Information

... > Entering RFQ Shipment Information

... > Entering RFQ Price Break Information
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Practice 1 OverviewPractice 1 Overview

This practice covers entering an approved supplier
for an item.
This practice covers entering an approved supplier
for an item.

Scenario
Your instructor has asked you to enter an approved supplier for an item you
created. You will also use the supplier you created. Make this supplier approved
for this item, select the Using AutoCreate release method.
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Practice 1 SolutionsPractice 1 Solutions

This practice covers entering an approved supplier
for an item.
1. Entering Key Attributes Tabbed Region
2. Recording Details Tabbed Region
3. Defining the Attributes of an ASL Entry

This practice covers entering an approved supplier
for an item.
1. Entering Key Attributes Tabbed Region
2. Recording Details Tabbed Region
3. Defining the Attributes of an ASL Entry

Practice 1 Solutions
Step 1: Key Attributes Tabbed Region
1. Open the Approved Supplier List window:
(N) Purchasing, Vision Operations > Supply Base > Approved Supplier List
2. Select M1 organization
3. Select Item from the Type drop-down list.
4. Select an item for which you will define an entry.
5. Go to the Suppliers region.
6. In the Business field, use the list of values to select the business type Direct.
7. In the Name field, use the list of values to select the supplier’s name.
8. In the Site field, enter the appropriate supplier site.
9. In the Status field, use the list of values to select Approved.
10. Optionally enter the supplier item.
11. Optionally specify a review-by date. You can use this date to determine
when a proactive business review should be performed for the supplier.
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Step 2: Record Details Tabbed Region
1. In the Global field choose Yes or No from the drop-down list to indicate
whether this item and supplier site combination should be available to all
organizations.
2. In the Owning Organization field, the organization that owns this item and
supplier site combination will default for you.
3. Click the Attributes button to access the Supplier-Item Attributes window.
Step 3: Defining the Attributes of an ASL Entry
1. In the Purchasing UOM field, use the list of values to select the purchasing
UOM.
2. In the Release Method field, use the list of values to select the release method
Release Using AutoCreate.
3. In the Source Documents region, select your Catalog Quotation.
4. Save your work.
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Practice 2 OverviewPractice 2 Overview

This practice covers the following topics:
• Creating a supplier list
• Creating an RFQ

This practice covers the following topics:
• Creating a supplier list
• Creating an RFQ

Scenario
Your company requires that when you negotiate new contracts and agreements
with suppliers a request for quotation be sent out to at least three suppliers.
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Practice 2 Instructions
with Solution

Practice 2 Instructions
with Solution

1. Create a supplier list
• Name the supplier list (Make sure you have named

it with a prefix of your initials)
• Make the list inactive in three months
• Use the list of values from the toolbar to select

vendors and sites
• Add two suppliers you create to your list, as well

as the following two suppliers: Advanced Network
Devices and Advantage Corp.

1. Create a supplier list
• Name the supplier list (Make sure you have named

it with a prefix of your initials)
• Make the list inactive in three months
• Use the list of values from the toolbar to select

vendors and sites
• Add two suppliers you create to your list, as well

as the following two suppliers: Advanced Network
Devices and Advantage Corp.

Practice 2 Solutions
Step 1: Create a Supplier List
1. Open the Supplier Lists window:
(N) Supply Base—>Supplier Lists
2. Name the Supplier List. (Make sure you have named it with a prefix  XX—
your initials or your terminal number.)
3. Make the list inactive in three months.
4. Add two suppliers you create to your list, as well as the following suppliers
(use the list of values from the toolbar to select vendors and sites):

• Advanced Network Devices
• Advantage Corp

5. Save your work.
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Practice 2 Instructions
with Solution

Practice 2 Instructions
with Solution

2.  Create a catalog RFQ (request for quotation)
• Change status to active
• Let the due date fall two weeks from today
• Close date is two weeks and one day away
• Quote approval is required
• The quote is effective for one year starting today

2.  Create a catalog RFQ (request for quotation)
• Change status to active
• Let the due date fall two weeks from today
• Close date is two weeks and one day away
• Quote approval is required
• The quote is effective for one year starting today

Practice 2 Solutions
Step 2: Create a Catalog RFQ
1. Open the RFQs window:
(N) RFQs and Quotations—>RFQs
2. In the Type field, use the list of values to selet Catalog RFQ.
3. In the Status field, use the list of values to select Active.
4. Enter a date in the Due Date field two weeks from today.
5. Enter a date in the Close Date field two weeks and one day away.
6. In the Reply Via field, use the list of values to make your choice.
7. Enter a description in the Description field.
8. Select the Quote Approval Required check box.
9. In the Quote Effectivity fields, let the quote be effective from today’s date to
one year from today.
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Practice 2 Instructions
with Solution

Practice 2 Instructions
with Solution

3.  Complete the terms
• Enter a line for two items you’ve created
• Ask for price breaks at 10, 25, and 50 for each item
• Reference your supplier list
• Add a note to the supplier asking for an expedited

response

3.  Complete the terms
• Enter a line for two items you’ve created
• Ask for price breaks at 10, 25, and 50 for each item
• Reference your supplier list
• Add a note to the supplier asking for an expedited

response

Practice 2 Solutions
Step 3: Complete the Terms.
1. Enter a line for two items you created.
2. Ask for price breaks at 10, 25, and 50 for each item. (Do not enter pricing,
supplier will reply with pricing information.)
3. Reference your supplier list.
4. Complete the terms. Click the Terms button.
5. Add a note to the supplier asking for an expedited response.
6. Save your work.
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AgendaAgenda

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations
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Overview of AutoCreating RFQsOverview of AutoCreating RFQs

Requisition
line
pool

Query existingQuery existing
lineslines

RFQRFQ

RFQRFQChoose linesChoose lines
fromfrom

query resultsquery results

AutomaticAutomatic
creationcreation

ManualManual
creationcreation

AutoCreating RFQs
Automatic Creation
Automatic Creation Mode lets you create RFQs with a minimum number of
keystrokes. You provide search criteria to locate the requisition lines you want
to place on an RFQ. After reviewing the requisition lines, you select all lines
that you want. Then you select the Automatic button to create the RFQ.
Manual Creation
Manual Creation Mode lets you specify which requisition lines you want to
place on a document. You decide which requisition lines you want to combine
and where you want them to appear on the document. Then you select the
Manual button to create the document.
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Finding Requisition LinesFinding Requisition Lines

Use the Find Requisition Lines window to specify
search criteria for requisition lines that you will use to
autocreate RFQs.

Use the Find Requisition Lines window to specify
search criteria for requisition lines that you will use to
autocreate RFQs.

(N) Oracle Purchasing > AutoCreate(N) Oracle Purchasing > AutoCreate

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
AutoCreate > Finding Requisition Lines for AutoCreate
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AutoCreating RFQsAutoCreating RFQs

Use the AutoCreate Documents window to create an
RFQ or other order documents.
Use the AutoCreate Documents window to create an
RFQ or other order documents.

(N) Oracle Purchasing > AutoCreate (B) Find(N) Oracle Purchasing > AutoCreate (B) Find

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
AutoCreate > Selecting AutoCreate Criteria
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Using the New Document Window:
Automatic Mode

Using the New Document Window:
Automatic Mode

Use the New  Documents window to complete the
automatic creation mode of autocreating RFQs.
Use the New  Documents window to complete the
automatic creation mode of autocreating RFQs.

(N) Oracle Purchasing > AutoCreate (B) Find
(B) Automatic
(N) Oracle Purchasing > AutoCreate (B) Find
(B) Automatic

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
AutoCreate > Entering Document Information and Completing
AutoCreate
Automatic Creation Mode
1. When you choose Create as your action and are in Automatic creation mode,
the New Document window is displayed.
2. Enter the New Document details and click create.
3. A new document is created.
4. Accept or edit the new document.
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Using the Document Builder:
Manual Mode

Using the Document Builder:
Manual Mode

Use the AutoCreate Documents window to complete
the manual creation mode of autocreating RFQs.
Use the AutoCreate Documents window to complete
the manual creation mode of autocreating RFQs.

(N) Oracle Purchasing > AutoCreate (B) Find
(B) Manual
(N) Oracle Purchasing > AutoCreate (B) Find
(B) Manual

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
AutoCreate > Using the Document Builder
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Adding to a DocumentAdding to a Document

Use the Add to Document window when adding to an
existing RFQ document.
Use the Add to Document window when adding to an
existing RFQ document.

(N) Oracle Purchasing > AutoCreate (B) Find
(B) Manual or Automatic
(N) Oracle Purchasing > AutoCreate (B) Find
(B) Manual or Automatic

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
AutoCreate > AutoCreate Document Options
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Practice 3 OverviewPractice 3 Overview

This practice covers the following topics:
• Finding requisition lines
• Selecting autocreation criteria

This practice covers the following topics:
• Finding requisition lines
• Selecting autocreation criteria
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Practice 3 SolutionsPractice 3 Solutions

This practice covers the following topics:
• Finding requisition lines
• Selecting autocreation criteria

This practice covers the following topics:
• Finding requisition lines
• Selecting autocreation criteria

Practice 3 Solutions
1. Open the Find Requisition Lines window:
(N) AutoCreate
2. In the Approved field, select Yes and leave all other fields blank.
3. Click Find to initiate the search and open the AutoCreate Documents
window.
4. To select your requsition, click the control button on your keyboard and left
click your mouse.
5. Click the Automatic button.
6. In the New Document window, accept the default, and click Create to
complete autocreation of the document.
7. Click OK.
8. The AutoCreate to RFQs window appears.
9. Fill in the remaining fields.
10. Save your work.
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AgendaAgenda

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations

• RFQs and Supplier Sourcing Introduction
• Manually Creating Requests for Quotation (RFQ)
• Autocreating RFQs
• Entering Quotations
• Suppliers Responding by way of iSupplier Portal
• Oracle Exchange: Creating a Buyer’s Auction
• Setup and Implementation Considerations
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Overview of QuotationOverview of Quotation

Request for quotations

Quote repository

Supplier 1 Supplier 2 Supplier 3 Supplier 4

Overview
Oracle Purchasing provides you with predefined quotation types.
•  Bid
•  Catalog
•  Standard
•  Quotations
When a supplier responds to a request for quotation, either verbal or written, you
will want to have a record of the pricing and terms commitments that are made.
You have two options to record quotation information:
•  You can manually enter the quotation in the system or,
•  You can use the Copy Documents window to create quotation directly from
RFQs.
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Quotation ApprovalsQuotation Approvals

Quote repository

Approve
Supplier 1

Item 1

Approve
 Supplier 1

Item 3

Approve
 Supplier 2

Entire quote

Approve
Supplier 3

Item 2

Supplier 1 Supplier 2 Supplier 3 Supplier 4

Quotation Approvals
Depending on your business requirements, you may approve or unapprove entire
quotations or a specific shipment in a quotation. You need to approve quotation
shipment if you want requestors or buyers to be able to reference the shipments on
purchase orders or requisition. Oracle Purchasing lets you approve quotation
shipment for specific purposes so that you can control the use of your sourcing
information.  Status of a quotation must be Active to be able to approve.
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Creating QuotationsCreating Quotations

Use the Quotations window to:
• enter and edit quotations
• review and edit quotations copied from RFQs

Use the Quotations window to:
• enter and edit quotations
• review and edit quotations copied from RFQs

(N) Oracle Purchasing > RFQs and Quotations >
Quotations
(N) Oracle Purchasing > RFQs and Quotations >
Quotations

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating Quotations

... > Entering Quotation Headers

... > Entering Quotation Lines

... > Entering Quotation Terms Information

... > Entering Quotation Shipment Information

... > Entering Quotation Price Break Information
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Entering Quotation LinesEntering Quotation Lines

Use the Quotations window to enter and edit
quotation lines.
Use the Quotations window to enter and edit
quotation lines.

(N) Oracle Purchasing > RFQs and Quotations >
Quotations (T) Items
(N) Oracle Purchasing > RFQs and Quotations >
Quotations (T) Items

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating Quotations

... > Entering Quotation Headers

... > Entering Quotation Lines

... > Entering Quotation Terms Information

... > Entering Quotation Shipment Information

... > Entering Quotation Price Break Information
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Editing Default CurrencyEditing Default Currency

Use the Currency window to edit the default currency
of the quotation and enter exchange rate information
(if applicable).

Use the Currency window to edit the default currency
of the quotation and enter exchange rate information
(if applicable).

(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Currency
(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Currency

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management >Creating Quotations

... > Entering Quotation Headers

... > Entering Quotation Lines

... > Entering Quotation Terms Information

... > Entering Quotation Shipment Information

... > Entering Quotation Price Break Information
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Editing Terms and ConditionsEditing Terms and Conditions

Use the Quotations Terms window to enter terms and
conditions information for quotations.
Use the Quotations Terms window to enter terms and
conditions information for quotations.

(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Terms
(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Terms

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating Quotations

... > Entering Quotation Headers

... > Entering Quotation Lines

... > Entering Quotation Terms Information

... > Entering Quotation Shipment Information

... > Entering Quotation Price Break Information
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Entering Price BreaksEntering Price Breaks

Use the quotation Price Breaks window to enter
pricing information for catalog quotations.
Use the quotation Price Breaks window to enter
pricing information for catalog quotations.

(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Price Breaks
(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Price Breaks

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating Quotations

... > Entering Quotation Headers

... > Entering Quotation Lines

... > Entering Quotation Terms Information

... > Entering Quotation Shipment Information

... > Entering Quotation Price Break Information
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Entering Shipment InformationEntering Shipment Information

Use the Quotation Shipment window to enter
shipment information for bid quotations.
Use the Quotation Shipment window to enter
shipment information for bid quotations.

(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Shipments
(N) Oracle Purchasing > RFQs and Quotations >
Quotations (B) Shipments

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Creating Quotations

... > Entering Quotation Headers

... > Entering Quotation Lines

... > Entering Quotation Terms Information

... > Entering Quotation Shipment Information

... > Entering Quotation Price Break Information
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Copyright   Oracle Corporation, 2000. All rights reserved.
®

Autocreating a QuotationAutocreating a Quotation

Use the Copy Document window to create quotations
directly from RFQs.
Use the Copy Document window to create quotations
directly from RFQs.

(N) Oracle Purchasing > RFQs and Quotations >
RFQs (M) Tools > Copy Document
(N) Oracle Purchasing > RFQs and Quotations >
RFQs (M) Tools > Copy Document

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Copying Quotations from RFQs
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Finding Quotations for ApprovalFinding Quotations for Approval

Use the Find Quotations window to search for
quotations to approve.
Use the Find Quotations window to search for
quotations to approve.

(N) Oracle Purchasing > RFQs and Quotations >
Quote Analysis (B) Find
(N) Oracle Purchasing > RFQs and Quotations >
Quote Analysis (B) Find

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Finding Quotations for Approval
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Analyzing QuotationsAnalyzing Quotations

Use the Analyze Quotations window to review and
approve general or specific quotation information of
an item or a purchasing category.

Use the Analyze Quotations window to review and
approve general or specific quotation information of
an item or a purchasing category.

(N) Oracle Purchasing > RFQs and Quotations >
Quote Analysis (B) Find > Analyze Quotations
(N) Oracle Purchasing > RFQs and Quotations >
Quote Analysis (B) Find > Analyze Quotations

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Approving Quotation Shipments
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Approving Entire QuotationsApproving Entire Quotations

Use the Approve Entire Quotation window to approve
or unapprove all shipments for a single quotation.
Use the Approve Entire Quotation window to approve
or unapprove all shipments for a single quotation.

(N) Oracle Purchasing > RFQs and Quotations >
Quote Analysis (B) Find > Analyze Quotations >
Approve Entire Quotation

(N) Oracle Purchasing > RFQs and Quotations >
Quote Analysis (B) Find > Analyze Quotations >
Approve Entire Quotation

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Supply Base Management > Approving Entire Quotations
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Copy DocumentsCopy Documents

• Reduces redundant data entry
Standard PO Standard PO
Blanket PO Blanket PO
Planned PO Planned PO
Bid Quotation Standard PO

Planned PO
Catalog Quote Blanket Purchase Agreement

• Automatically assigns next document number

• Reduces redundant data entry
Standard PO Standard PO
Blanket PO Blanket PO
Planned PO Planned PO
Bid Quotation Standard PO

Planned PO
Catalog Quote Blanket Purchase Agreement

• Automatically assigns next document number

Copy Documents
(N) Query PO > Tools > Copy Document > Include/Exclude Attachments
You can copy one purchase order to another. For example, if you want to renew a
blanket purchase agreement that contains hundreds of lines, you can copy the
previous agreement to a new agreement and change the effectivity dates. You can
create new purchase orders and agreements by copying standard, blanket, planned
purchase orders, as well as bid and catalog class quotations.
Note: If manual numbering is set up, then add document number. Cancelled lines
are copied (not cancelled).

Approve after copy
There is no validation at time of copy, but at time of approval, except
encumbrance:
•  Item attributes
•  Supplier site
•  Encumbrance
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Practice 4 OverviewPractice 4 Overview

This practice covers the following topics:
• Creating a quotation automatically
• Approving an entire quotation

This practice covers the following topics:
• Creating a quotation automatically
• Approving an entire quotation
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Practice 4 SolutionsPractice 4 Solutions

This practice covers the following topics:
• Creating a quotation automatically
• Approving an entire quotation

This practice covers the following topics:
• Creating a quotation automatically
• Approving an entire quotation

Practice 4 Solutions
Step 1: Automatically create a quotation from an RFQ. Copy the entire RFQ,
but do not include an attachment.
1. Open the Copy Document window:
(N) RFQs and Quotations—>RFQs (M) View —> Find (M) Tools—>Copy
Document.
2. In the Copy Document window, select Edit to choose the list of values.
3. Use the list of values to choose the copy-from action: Entire RFQ.
Note: Enter a quotation number if you are using manual quotation numbering. If
your setup is for automatic quotation numbers, Oracle Purchasing will assign a
number when you save your work.
4. Use the list of values to enter the type.
5. Use the list of values to enter the supplier.
6. Use the list of values to enter the site.
7. Use the list of values to enter the contact.
8. Click OK to copy the RFQ.
9. Enter supplier pricing. Include price breaks for requested quantity.
10. Change the status to Active.
11. Save your work.



Copyright © Oracle Corporation, 2000. All rights reserved.

Issue RFQs to Obtain Bids and Quotations
Chapter 1 - Page 54

Step 2: Approve an Entire Quotation
1. Click the Approve button.
2. In the Approve Entire Quotation window, select Edit to choose the List of
Values.
3. Use the list of values to enter the approval type of your quotation.
4. Use the list of values to enter the approval reason.
5. Use the list of values to enter the effective date range.
6. Enter comments about the approval in the Comments field.
7. Click OK to approve.
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• Gives suppliers direct access to information that
affects them

• Gives suppliers visibility across the plan-to-
procure-to-pay lifecycle

• Suppliers can perform transactions using the
Internet

• Provides a collaborative environment where
suppliers become integrated partners

• Gives suppliers direct access to information that
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• Gives suppliers visibility across the plan-to-
procure-to-pay lifecycle

• Suppliers can perform transactions using the
Internet

• Provides a collaborative environment where
suppliers become integrated partners
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Using iSupplier Portal
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Supplier Portal
www.global.com

SupplierSupplier Oracle
Internet

Procurement

InternetInternet InternetInternet
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Benefits of iSupplier Portal
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Suppliers proactively service themselves, accessing
the information they need to serve you — the
customer — better:
• Reduces operating costs
• Frees up staff time
• Compresses cycle times
• Improves service

Suppliers proactively service themselves, accessing
the information they need to serve you — the
customer — better:
• Reduces operating costs
• Frees up staff time
• Compresses cycle times
• Improves service
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Information Available for Supplier Review
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• RFQs
• Purchase orders and change history
• Receipts, open deliveries, delivery performance,

and returns
• Invoice and payment information
• Supplier item summary
• Consolidated shipping and planning schedules

• RFQs
• Purchase orders and change history
• Receipts, open deliveries, delivery performance,

and returns
• Invoice and payment information
• Supplier item summary
• Consolidated shipping and planning schedules
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Viewing Request for Quotations (RFQ)
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Use the Requests for Quotation window to view a
summary of opportunities on which to bid.
Use the Requests for Quotation window to view a
summary of opportunities on which to bid.

Viewing Requests for Quotation
(N) Supplier Services by Supplier > View Request for Quotations (B) Search
Suppliers can review requests for quotation created in Oracle Purchasing. They
can search for requests for quotation using various search criteria. They will
have access to all documents for which they are listed as a potential supplier.
The information displayed can be exported into a file that can be uploaded to
the supplier’s own system to generate a response. Those responses can then be
sent back through the Oracle eCommerce Gateway. Drill-down capabilities
allow suppliers to drill-down to RFQ details.
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• Auction Type
– Buyer’s Auction
– Seller’s Auction

• Process Flow
– Create Auction
– Place Bid
– Award Auction
– Inquiries

• Auction Type
– Buyer’s Auction
– Seller’s Auction

• Process Flow
– Create Auction
– Place Bid
– Award Auction
– Inquiries

Overview
Oracle Internet Procurement will support RFQs & Quotations that are a result of a
Buyer Auction (Reverse Auction) in Oracle Exchange.
Buyer’s Auction:
Buyer publishes items they want to purchase
Seller’s Auction:
Seller publishes items they want to sell



Copyright © Oracle Corporation, 2000. All rights reserved.

Issue RFQs to Obtain Bids and Quotations
Chapter 1 - Page 63

Creating an Auction
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• Business terms and conditions
– Auction currency and price precision

• Load items
– Online, Spreadsheet, Catalog items
– Setup bid attributes for each item

• Bid controls
– Autoextend, Open vs. Sealed, Bid All items

• Invite members or non-members to bid
• Review and Publish

• Business terms and conditions
– Auction currency and price precision

• Load items
– Online, Spreadsheet, Catalog items
– Setup bid attributes for each item

• Bid controls
– Autoextend, Open vs. Sealed, Bid All items

• Invite members or non-members to bid
• Review and Publish

XML
Enables the auctioneer, at the time of auction award, to generate an XML PO
which can be integrated into a wide variety of back-end systems, including ERP
applications.
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Placing a Bid
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• Search by auctioneer, item or events
• View auction details and current best bid
• Bid on price, lead time and quantity
• Attribute based bidding
• Review bid changes and submit
• View bid status and monitor bidding action
• Optionally, export auction and bid offline

• Search by auctioneer, item or events
• View auction details and current best bid
• Bid on price, lead time and quantity
• Attribute based bidding
• Review bid changes and submit
• View bid status and monitor bidding action
• Optionally, export auction and bid offline

AutoExtend
•  Ability to automatically extend the auction closing time if a new lowest priced
bid is received within the last specified number of minutes.
•  Auction extends from the time the new lowest bid was received
•  Pprevents a bidder from undermining the ability of other bidders to re-bid on the
current best price
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• View bid history
• Export all bids for offline analysis
• Compare all active bids for each item
• Award each item to multiple bidders
• Automatically notify bidders of award decision

• View bid history
• Export all bids for offline analysis
• Compare all active bids for each item
• Award each item to multiple bidders
• Automatically notify bidders of award decision

Proxy Bid
•  Bidder enters current bid, proxy bid inc/dec, and proxy max/min bid.  As better
bids are received, the system will automatically re-bid based on the entered
information
•  Once bidding reaches min/max price, bidder can manually bid or reset proxy
bidding
•  Bidder can proxy bid on some items and manually bid on other  items
Power Bid
• When re-bidding, the bidder can elect to change all current bid prices
systematically by a specified %.
AutoRefresh
•  After placing a bid, a bidder can monitor the bidding in an auction or event at
pre-specified automatic intervals.
•  Continual updates allow bidder to watch changes rather than hit reload
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Setup requirements and options enable you to:
• Choose sourcing rules
• Create and control default information
• Provide or restrict authorization to create, modify,

and approve documents

Setup requirements and options enable you to:
• Choose sourcing rules
• Create and control default information
• Provide or restrict authorization to create, modify,

and approve documents

Setup requirementsSetup requirements
and optionsand options

Oracle Purchasing Setup Options
Setup is required in Oracle Purchasing to facilitate supplier sourcing
activitiessuch as these:
•  Sourcing options
•  Requests for quotations
•  Quotations
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Issues to consider:
• RFQ and quotation usage
• Supplier sourcing conversion
• Supplier sourcing maintenance
• Data mapping
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Issues to consider:
• RFQ and quotation usage
• Supplier sourcing conversion
• Supplier sourcing maintenance
• Data mapping
• Data cleanup

Issues to Consider
1. RFQ and quotation usage

– What types of purchases will require RFQ’s and quotations?
– Will approval of quotations be required?

2. Supplier sourcing conversion
– Will current RFQ’s and quotations be converted?
– How will existing RFQ’s and quotations be converted; automated

conversion, manual data entry, or both?
3. Supplier sourcing maintenance

– Who will create and maintain RFQ and Quotation data?
4. Data mapping

– How will your data mapping be done?
– What data in legacy system will determine values in Oracle

Purchasing tables?
– How will additional fields be derived and loaded?

5. Data clean up
– Will expired quotations be converted?
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Use the Purchasing Options window to setup
automatic numbering for:
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• Quotes

Use the Purchasing Options window to setup
automatic numbering for:
• RFQs
• Quotes

(N) Oracle Purchasing > Setup > Organizations >
Purchasing Options (T) Numbering
(N) Oracle Purchasing > Setup > Organizations >
Purchasing Options (T) Numbering

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Setting Up > Defining Purchasing Options
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Use the Document Types window to define access,
security, and control specifications for all Purchasing
document types.

Use the Document Types window to define access,
security, and control specifications for all Purchasing
document types.

(N) Oracle Purchasing > Setup > Purchasing >
Document Types
(N) Oracle Purchasing > Setup > Purchasing >
Document Types

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Setting Up > Defining Document Types
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Use the Line Types window to clearly differentiate
orders for goods from those for Amount-based
services or outside processing.

Use the Line Types window to clearly differentiate
orders for goods from those for Amount-based
services or outside processing.

(N) Oracle Purchasing > Setup > Purchasing >
Line Types
(N) Oracle Purchasing > Setup > Purchasing >
Line Types

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Setting Up > Defining Line Types
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Use the Hazard Classes window to identify and
classify hazardous materials and print information on
your RFQs and purchase orders to ensure that your
suppliers pack, label, and ship hazardous materials
according to the regulations.

Use the Hazard Classes window to identify and
classify hazardous materials and print information on
your RFQs and purchase orders to ensure that your
suppliers pack, label, and ship hazardous materials
according to the regulations.

(N) Oracle Purchasing > Setup > Purchasing >
Hazard Classes
(N) Oracle Purchasing > Setup > Purchasing >
Hazard Classes

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Setting Up > Defining Hazard Classes



Copyright © Oracle Corporation, 2000. All rights reserved.

Issue RFQs to Obtain Bids and Quotations
Chapter 1 - Page 73

UN Numbers

Copyright   Oracle Corporation, 2000. All rights reserved.
®

UN NumbersUN Numbers

Use the UN Numbers window to:
• define United Nations identification numbers for

hazardous material.
• associate a hazard class with multiple

dentification numbers.
• assign an identification number and hazard class

to each item you define.

Use the UN Numbers window to:
• define United Nations identification numbers for

hazardous material.
• associate a hazard class with multiple

dentification numbers.
• assign an identification number and hazard class

to each item you define.

(N) Oracle Purchasing > Setup > Purchasing >
UN Numbers
(N) Oracle Purchasing > Setup > Purchasing >
UN Numbers

(Help) Oracle Manufacturing Applications > Oracle Purchasing >
Setting Up > Defining UN Numbers
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Enter Enter 
RFQRFQ

Gateway

Internet ProcurementInternet Procurement

PaperPaper

PaperPaper

iSupplieriSupplier Portal Portal

QuotesQuotes
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In this course, you should have learned how to:
• Create requests for quotations
• Record quotation responses
• Describe Oracle Exchange and Oracle e-

Commerce Gateway RFQ features
• Perform setup and implementation requirements

for RFQs

In this course, you should have learned how to:
• Create requests for quotations
• Record quotation responses
• Describe Oracle Exchange and Oracle e-

Commerce Gateway RFQ features
• Perform setup and implementation requirements

for RFQs

Summary
Oracle Purchasing provides you with request for quotation (RFQ) and quotation
features to handle your sourcing needs. You can create an RFQ from requisitions,
match supplier quotations to your RFQ, and automatically copy quotation
information to purchase orders.
Although you do not need a purchase requisition to create requests for quotation,
they often provide the signal to procure material. Oracle Purchasing lets you
source your items so you can negotiate the best deals with your suppliers.
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